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Purpose of this document
This document describes the functionality and intended usage of MacroView 
ClauseBank. It is also a guide for Administrators responsible for the 
maintenance of MacroView ClauseBank.

Legal Notice
MacroView ClauseBank and components are produced and licensed by 
MacroView Business Technology Pty Limited (MacroView). 

This guide contains material that is copyright to MacroView. It should not be 
copied or otherwise reproduced without express permission from MacroView.

Disclaimer
Every precaution has been taken in the preparation of this documentation 
however MacroView assumes no responsibility for errors or omissions, or for 
damages resulting from the use of the information contained herein.

Trademarks
MacroView and MacroView ClauseBank are registered trademarks of 
MacroView Business Technology Pty Limited in Australia, USA, Canada and all 
countries that are signatories to the Madrid convention.

Microsoft, Microsoft Office, Microsoft PowerPoint, Microsoft Word, Microsoft 
Outlook and Microsoft SharePoint are all trademarks of Microsoft Corporation.

Copyright
© 2004-2020 MacroView Business Technology Pty Limited.
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1 Introduction
MacroView ClauseBank makes it easy to publish, retrieve and insert frequently 
needed standard text and graphics into your Word documents, Outlook 
messages and PowerPoint presentations. Whether you generate sales 
proposals, financial plans, legal documents or general correspondence, 
ClauseBank makes Word, Outlook and PowerPoint more productive.

All organisations have standard text and graphics that are frequently required 
for inclusion in documents being generated. With MacroView ClauseBank, this 
material is published in a convenient central SharePoint website. This site can 
be accessed over any internet connection, which means that all staff, 
regardless of their location, can have convenient and immediate access to the 
latest standard material. 

MacroView ClauseBank ensures that only up to date material is retrieved from 
this central SharePoint website. The automatic Expiry Alert feature of 
MacroView ClauseBank assists in maintaining the content so that it is up to 
date.

MacroView ClauseBank eliminates the time wasted in searching for material in 
previously generated documents and the risk of using an out-of-date copy.

Clauses can contain MacroView Precedent mark-up tags and can be used in 
conjunction with MacroView Precedent.
MacroView ClauseBank is the result of MacroView’s extensive experience with 
the development of custom document automation solutions for some of 
Australia’s leading banks, law firms and many other organisations. This is 
combined with leading technical skills in Microsoft Office, Microsoft SharePoint 
and SharePoint Online (O365).
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2 Where does ClauseBank surface?
MacroView ClauseBank can be installed in Office 2010, 2013 and 2016.

If the MacroView ClauseBank facility has been installed, the MacroView 
ClauseBank tab is available on the Insert tab of the Ribbon in your Word, 
PowerPoint and Outlook environments. There is also a ClauseBank tab on the 
Home tab on the Ribbon.

Note: Before you can use ClauseBank you must first configure one or 
more ClauseBank servers. Refer to section 9.1.2 for information on 
adding, editing and removing content sources.

2.1 Word
MacroView ClauseBank adds a ClauseBank group to both the Home and Insert 
tabs on the Word Ribbon. On the Home tab the buttons include:

Insert Clause – allows you to insert clauses at the current cursor position in 
the active document

Insert ClauseLink – allows you to insert ClauseLinks at the current cursor 
position in the active document

New Clause – allows you to create a new clause by selecting text in the 
current document

Expand – replaces all ClauseLinks in the active document with the actual 
clauses

Options - allows you to configure your ClauseBank.

Figure 1: The MacroView ClauseBank button on the Home tab in Microsoft Word 2013

Only the Clause and ClauseLink buttons are available on the Insert tab.

Figure 2: The MacroView ClauseBank buttons on the Insert tab in Microsoft Word 2013

If there is no document open in Word the following message will display if you 
click on the Insert Clause, Insert ClauseLink or Expand buttons.

Figure 3: The MacroView ClauseBank message that displays when no document is open

The New Clause button is greyed out until you select text.

2.1.1 Inserting PowerPoint clauses in Word
When in Microsoft Word, you can insert Clauses/Slides created in Microsoft 
PowerPoint if the Allow PowerPoint slides in Word option is selected. The 
PowerPoint slide is inserted as an object. (Figure 4)
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Figure 4: Inserting PowerPoint clauses into Word documents using ClauseBank

2.2 PowerPoint
MacroView ClauseBank adds a ClauseBank group to both the Home and Insert 
tabs on the PowerPoint Ribbon. On the Home tab the buttons include:

Insert Clause – allows you to insert clauses at the current cursor position in 
the active presentation

New Clause – allows you to create a new clause by selecting text and 
graphics in the current presentation

Options - allows you to configure your ClauseBank.

Figure 5: The MacroView Insert Clause, New Clause and Options buttons on the Home tab in Microsoft 
PowerPoint 2013

Only the Insert Clause button is available on the Insert tab.
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Figure 6: The MacroView Insert Clause button on the Insert tab in Microsoft PowerPoint 2013

If there is no presentation open in PowerPoint the following message will 
display if you click on the Insert Clause button.

Figure 7: The MacroView ClauseBank message that displays when no presentation is open

2.2.1 Inserting Word clauses in PowerPoint
When in Microsoft PowerPoint, you can insert Clauses created in Microsoft 
Word if the Allow Word clauses in PowerPoint option is selected. The Word 
clause is inserted as an object. (Figure 8)

Figure 8: Inserting Word clauses into PowerPoint documents using ClauseBank



 
MacroView ClauseBank User Guide

Effective: September 2020 8

2.3 Outlook
MacroView ClauseBank adds a ClauseBank group to both the Message and 
Insert tabs on the Outlook Ribbon. On the Message tab the buttons include:

Insert Clause – allows you to insert clauses at the current cursor position in 
the active email message

Options - allows you to configure your ClauseBank.

Figure 9: The MacroView Insert Clause and Options buttons on the Message tab in Microsoft Outlook 2013

Only the Insert Clause button is available on the Insert tab.

Figure 10: The MacroView Insert Clause button on the Insert tab in Microsoft Outlook 2013

3 Insert Clause
When you click on the button to insert a clause, the MacroView ClauseBank 
screen displays. This screen is populated by retrieving clauses from a central 
SharePoint site (the ClauseBank site). Clauses are organised into Libraries and 
within each library into Folders or by Category.

Using the MacroView ClauseBank screen, you can preview any clause and 
select either a single clause or a number of clauses for insertion into the current 
Word document, Outlook message or PowerPoint presentation.

MacroView ClauseBank automatically remembers your most recently selected 
ClauseBank Library the next time that you use MacroView ClauseBank.

3.1 Displaying ClauseBank Sites
The first time you use MacroView ClauseBank you will be see a tree-view1 of 
the ClauseBank sites that you have permission to access - potentially on 
multiple SharePoint servers and/or SharePoint Online (O365).

Figure 11: When you first use ClauseBank you see the tree-view of ClauseBanks available to you

Any site can be added as a ClauseBank. See Section 9.1.2 for details on 
adding ClauseBanks to your list.

1 This was previously known as the Browse Tree-View mode. Note that the Details mode has been deprecated.
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3.2 Displaying Libraries
The tree-view depicts the Clause Libraries available in each ClauseBank site.

Click the arrow to expand the ClauseBank site node. MacroView will then 
display the ClauseBank libraries that you have permission to access within that 
site.

By default only those document libraries whose names end in Clauses and 
Slides, will be displayed. Historically Clauses libraries contained Word 
documents and pictures that were only available for insertion in Word and 
Outlook while Slides libraries contained PowerPoint presentations and pictures 
that were only available for insertion in PowerPoint. This restriction no longer 
exists.

If the ClauseBank option Display all Document Libraries is checked all libraries 
(with the exception of those displayed in the exclusion list) will be displayed.

3.3 Displaying Folders and Categories2

The tree-view also depicts the Folders or Categories in each Clause Library. 
The advantage of using folders to categorise your clauses is that you can create 
up to 10 levels of subfolders. There is only one level for Categories.

By default, MacroView ClauseBank will provide navigation of the clause library 
by its folder and sub folder structure. If you wish to use categories to navigate 
the clause library a site column named Categories is required (refer to the 
MacroView ClauseBank Administration Guide).

Note that if you add a Folder to a library the Categories column will be ignored 
by the ClauseBank.

3.4 Clause List and Folders
If you are using Folders to categorise your clauses, MacroView will display the 
ClauseBank Folders within that library when you click the arrow sign to expand 
the ClauseBank library node. (Figure 14).

Figure 12: The relationship between Folders and Clauses list

When using navigation by Folder an All Folders option appears as the first 
‘Folder’ for all libraries so that all clauses available in the library can be viewed 
in one list.  The All Folders node can be disabled under settings.

If you click on a particular Folder only the clauses in that Folder will display in 
the clause list (Figure 15).

2 Folders, Categories and clauses appear in alphabetical order.
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3.5 Clause List and Categories
If you are using Categories to categorise your clauses, all clauses in that library 
appear in the Clauses list when you click the arrow to expand the ClauseBank 
Library node the library is highlighted causing. (Figure 13)

Figure 13: Clauses in ‘Letter Clauses’ library

If you are using Categories to categorise your clauses, MacroView will display 
the ClauseBank categories within that library when you click the arrow sign to 
expand the ClauseBank library node. (Figure 14).

Figure 14: Categories in ‘Letter Clauses’ library

When using navigation by category an All Categories option appears as the 
first category for all libraries so that all clauses available in the library can be 
viewed in one list.  The All Categories node can be disabled under settings.

The ‘No Category’ option appears if the Option Display ‘No Category’ category 
is ticked. Any clauses that have not been categorised will appear in the Clause 
List when this option is selected.

If you click on a particular category only the clauses in that category will display 
in the clause list (Figure 15).
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Figure 15: A selected category with clauses displayed.

When you click on a Category, the valid clauses in that Category are displayed 
in the Clauses list. Valid clauses are those clauses that have not exceeded their 
Expiry Date.

If there are no valid clauses for a particular Category and the option to Display 
Expired Clauses is not selected then the Category will appear in the list and will 
display No clauses to display in the clauses list.

If there are no valid clauses for any category the All Categories will display No 
clauses found… in the clauses list (Figure 16).

Figure 16: The relationship between Categories and Clauses list

If there are no clauses created for a particular Category then that Category will 
not appear in the list.
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3.6 Previewing a Clause
You can preview clauses before selecting them to check that you are selecting 
the appropriate clause by using the Preview Pane or the Preview Window.

Note that clicking a hyperlink contained in the preview text will not work if the 
selected clause is stored in the Clause Library as a Word document.

3.6.1 Preview Pane
When you click on a clause in the Clause list, the Preview pane shows a fully-
formatted display of the currently selected clause (Figure 17). Clicking on the 
Show Preview / Hide Preview toggles the pane open and closed.

Note: ClauseBank does not ship with the Show Preview / Hide Preview toggle 
button visible. The Display view toggle buttons in Options, ClauseBank Options, 
General needs to be ticked.

If the Options, ClauseBank Options, Advanced, Display preview is not ticked 
ClauseBank will always start with the Preview pane closed.

If the clause is longer than a page click the left and right arrows at the bottom of 
the Preview pane to page through the clause.

Figure 17: Multi-page clause displayed in Preview pane 

3.6.2 Full-screen preview window
Clicking the Full Screen Preview button will cause the preview to be displayed 
in a full screen window (Figure 18). This is useful for reading through longer 
clauses.

If the Use full screen XPS previews option in Options, ClauseBank Options, 
Advance is ticked you will also be able to select and copy text from clauses in 
the full screen preview window.

Note: ClauseBank does not ship with Full Screen Preview button visible. 
Toggle Allow full screen preview in Options, ClauseBank Options, General.

If the clause is longer than a page click the left and right arrows at the bottom of 
the Preview window to page through the clause.

Preview Clause button

Prev / Next page buttons

Prev /Next page buttons
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Figure 18: Multi-page clause displayed in Preview window

Clicking the Close cross at the top right of the window will close the Preview 
Clause window (Figure 18).

Figure 19: MacroView ClauseBank with Preview pane closed

3.7 Displaying the Clause Description
When you click on a clause in the Clause list the Description pane displays 
any description text that has been created with the clause. This text is useful in 
assisting you to know when to use this particular clause. It can include 
hyperlinks to websites to provide extra information and email addresses.

Clicking on the Show Description / Hide Description toggles the pane open 
and closed (Figure 20).

Note: ClauseBank does not ship with the Show Description / Hide 
Description toggle button visible. The Display view toggle buttons in Options, 
ClauseBank Options, General needs to be ticked.

If the Options, ClauseBank Options, Advanced, Display description is not ticked 
ClauseBank will always start with the Description pane closed.
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Figure 20: Single-page clause displayed in Preview pane with description

3.8 Searching for Clauses in the Clauses List
To restrict the list of clauses in the Clauses list, type text in the search box and 
then click the search button. You can filter clauses based on text found within 
the name of the clause or by text found in the content of the clause.

3.8.1 Filter by ‘Name contains’
By default, the search type is Name contains. Type part of the clause name in 
the filter box that appears above the list.

Figure 21: Only those Clauses whose names contain the characters ‘equities’ are listed

ClauseBank will automatically restrict the list of Clauses to be only those whose 
names contain the characters that appear in the filter box.

To clear the filter, click the Clear Search button or clear the search text.

If the Capitalise filter argument setting is ticked, ClauseBank will display the 
filter characters in UPPER CASE within the names of the clauses in the 
Clauses list. See Section 9.1.1 for more detail about this setting.

Note: The Filter by ‘Name Contains’ is not available at the site level. See 3.8.3 
Advanced Search options below for more functionality.

3.8.2 Filter by ‘Clause contains’
Although this is referred to as a filter it actually uses the SharePoint Search. 
The SharePoint Search must be configured and a crawl run before a search will 
be successful.

Clear sort button
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Note that the Filter by Clause contains option is available if using Microsoft 
SharePoint Server 2010, SharePoint Foundation 2013, SharePoint Server 
2013, SharePoint Server 2016 or SharePoint Online (Office 365).

Select the filter type Clause contains. Type the text that you want to search for 
in the contents of the clause in the search box that appears above the list. The 
search is dynamic and completes when you stop typing (Figure 22).

Figure 22 Only those clauses that contain 'planning' in their body are listed

ClauseBank will automatically restrict the list of Clauses to be only those whose 
content contains the characters that appear in the search box.

To clear the filter, click the Clear Search button.

The Filter by ‘Clause Contains’ is available at the site level if you tick the Option, 
Enable clause search on sites.

3.8.3 Advanced Search options
If you tick the Option, Advanced setting Display advanced search options you 
will be provided with the following dropdown list of filter options instead of the 
Name contains or Clause contains options.

Figure 23 Advanced search options

Phrases may only contain whole words. In the example below if the ‘s’ is left off 
‘fees’ no items are returned. (Figure 24).



 
MacroView ClauseBank User Guide

Effective: September 2020 16

Figure 24 Advanced search for the phrase ’entry fees’

If you are searching for Clause that contains at least one of these words then 
you enter the individual whole words separated by a space. The example below 
shows the clauses that contain the words ‘securities’ and/or investment’. (Figure 
24).

 Figure 25 Advanced search for the words ‘securities’ and/or investment’

The results returned rely on the configuration of your SharePoint search3.

3.9 Selecting Clauses to Insert
You can select the clauses and move them into the Selected Clauses list. You 
can choose a combination of clauses from various libraries and categories if 
you so desire. To move clauses into the Selected Clauses list you can:

drag and drop the clauses

double click on the clauses

click the move button

right click and choose Add to Selected Clauses (Figure 25).

3 Expired content will be returned by the advanced search.

Move button
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Figure 26: Insert clauses using Add to Selected Clauses 

If Allow duplicate clauses is ticked in Options, General tab, you will be able to 
select and move each clause into the Selected Clauses list multiple times. 
(Figure 27).

Figure 27: Multiple copies of the clauses can be selected.
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3.10 De-Selecting Clauses
To remove a clause from the Selected Clauses list, click to select the clause in 
your Selected Clauses list then click the Remove Clause button (Figure 28 
and Figure 29).

Figure 28: Before clicking the Remove Clause button.

Figure 29: After clicking the Remove Clause button the clause no longer appears in the Selected Clauses 
list.

Remove clause 
button
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3.11 Changing the Order in which Clauses will be Inserted
Clauses will be inserted into your document in the order in which they appear in 
the Selected Clauses list. To change the order of clauses in the Selected 
Clauses list you can drag and drop the clauses to move them up and down the 
list or click on a clause in that list and click the Move clause up or Move 
clause down buttons until the clauses are in the order that you require (Figure 
30).

Figure 30: Adjusting the ordering of your Selected Clauses list

Move clause up
Move clause down 

buttons
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3.12 Inserting Clauses
When you have selected and ordered the clauses that you want to insert, click 
the OK button (Figure 31).

Figure 31: Clicking the OK button will insert selected clauses into your document.

3.12.1 Right-click Insert
Alternatively if you tick the Option, Advanced setting Allow clause to insert on 
right click you can select the clauses in the clause list, then right click, choose 
Insert to have them placed in the current document without moving them into 
the selected clauses panel.

Figure 32: Right click, Insert will insert selected clauses into your document.
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4 Insert ClauseLink
When you click on the Insert ClauseLink button, the MacroView ClauseBank 
screen displays. The functionality of this screen is as described in section 3 
above. When you click OK, instead of inserting the clauses in the clause list, 
links to each of the clauses are inserted in the document (Figure 33).

"Business Day" means a day, other than a Saturday or Sunday, on which 
banks are open in Hong Kong to the general public for business;

Figure 33: Inserted ClauseLinks

Clause Link: Business Day

Clause Link: Company

The advantage of inserting ClauseLinks in certain documents rather than 
inserting actual clauses is that the clauses can be expanded when the 
document is being prepared for issue guaranteeing that the latest version of the 
clause is included. This is important for clauses that may update regularly with 
legal or fee information for instance.

You can also include ClauseLinks within other clauses.

Note that ClauseLinks are only available in Microsoft Word.

https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
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5 Expanding ClauseLinks
There are two ways to expand ClauseLinks – the Expand ClauseLinks tick box 
on the Insert Clause dialog or using the Expand button on the ribbon.

5.1 Expand ClauseLinks tick box
If a clause contains ClauseLinks the ClauseLinks will not expand when you 
insert the clause unless you tick the Expand ClauseLinks box. If you tick this 
box the ClauseLinks within the clause are expanded immediately after the 
clause is inserted. (Figure 34).

Figure 34: Inserted ClauseLinks

THE PARTIES AGREE that:

Definitions
In this Deed, unless the context requires otherwise:

 "Business Day" means a day, other than a Saturday or Sunday, on which 
banks are open in Hong Kong to the general public for business;

 "Company" means [●] a company under the laws of [●], particulars of which 
are set out in Schedule 1;

5.2 Expand button
When you click on the Expand button, every ClauseLink in the document will be 
replaced by the latest version of the appropriate clause stored in the Clause 
library.

You will be prompted to confirm that you want to expand all ClauseLinks in the 
document (Figure 35 and Figure 36).
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Figure 35: Dialog to confirm expansion of all ClauseLinks in the document

Clause Link: Business Day

Clause Link: Company

"Business Day" means a day, other than a Saturday or Sunday, on which 
banks are open in Hong Kong to the general public for business;

"Company" means [●] a company under the laws of [●], particulars of which 
are set out in Schedule 1;
Figure 36: Expanded ClauseLinks

https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Business%20Day.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx
https://portal.macroview.com.au/sites/ClauseBank/ClauseBankDemo/Definition%20Clauses%202/Company.docx


 
MacroView ClauseBank User Guide

Effective: September 2020 24

6 Right click menus on the Tree-view nodes

6.1 Refresh
Refresh updates the current node of the tree and everything below. So for 
example if you have selected a server node, Refresh updates all ClauseBanks, 
libraries, categories and clauses on that server. If you have selected a library 
node Refresh updates all categories and clauses in that library.

The Refresh option appears when you right click a site, library or folder. (See 
Figure 37) You can also select a site library or folder and press F5 to refresh.

If you Enable incremental tree refresh under ClauseBank Options new and 
removed libraries and folders will be reflected in the tree automatically when:

 Opening the Insert window and the selected treeview item is a library, 
folder or category.

 Selecting a Library, Category or Folder treeview item.

 Clearing the clause filter text.

 Right-clicking the clauses list and selecting Refresh.

6.2 Open in browser
MacroView ClauseBank allows quick and easy access to the SharePoint sites 
and libraries that contain the clauses (Figure 37).

If the Options, General, Allow open in browser is ticked the Open in browser 
option appears in the menu when you right click a site or a library.

If you click the Open in browser option the selected site or library will be 
opened in SharePoint.

Figure 37 Open in browser and Refresh from site node

6.3 Create ClauseBook
The ClauseBook function writes the content and information about all the 
clauses in a selected Clause Library into the current Word document at the 
cursor position.

This Word document can be based on a template that controls the layout of 
ClauseBooks so that the text complies with the formatting requirements of your 
organisation. This functionality is particularly useful for Content Managers and 
ClauseBank administrators for reviewing their ClauseBanks.
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If the Options, General, Enable ClauseBook is ticked the Create ClauseBook 
option appears in the menu when you right click a library.

To create a ClauseBook for a Clause Library, select the library then right click 
and choose Create ClauseBook (Figure 37).

The ClauseBook will start with the Library name, Library URL and the date. This 
is followed by the clause name, clause category, description and clause content 
for each clause in alphabetic order. (See sample ClauseBook in Figure 38.)

Figure 38: A ClauseBook for the Definition Clauses library

If the Options, Advanced, Enable modeless insert window is ticked the 
ClauseBank dialog won’t close after creating a ClauseBook. If it is not ticked the 
ClauseBank will close automatically after creating the ClauseBook.
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7 Creating new clauses
The New Clause button appears on the ribbon in Word, PowerPoint and 
Outlook, if enabled in Options, General, Enable New Clause button. If this 
option is not selected, the button is not available.

New Clause is also available as a right click option when text is selected.

7.1 In Word
If you have text in a Word document that you would like to add as a clause 
select the clause and choose the New Clause button on the ribbon.

Figure 39: Create New Clause

Type a name for the clause and select the appropriate folder or library in the 
tree view in the Create New Clause dialog then click Save.
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Figure 40: Save the new clause

You will then be prompted to enter the metadata for that clause and then click 
OK.

Figure 41: Enter the metadata for the new clause

Once you refresh the ClauseBank site, library or folder the new clause will be 
visible.
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Figure 42: New GST Clause available in a subfolder of the ClauseBank

7.2 In PowerPoint
If you have content in a PowerPoint presentation that you would like to add as a 
clause select the content and choose the New Clause button on the ribbon.

Figure 43: Create New Clause

Type a name for the clause and select the appropriate folder or library in the 
tree view in the Create New Clause dialog then click Save. 

You will then be prompted to enter the metadata for that clause and then click 
OK.

Note that you are not prompted for a Content expert in PowerPoint
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Figure 44: Enter the metadata for the new clause

Once you refresh the ClauseBank site, library or folder the new clause will be 
visible.

7.3 In Outlook

Figure 45: New Clause in the Outlook Ribbon

Select the text and the New Clause button will be available. 
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8 MacroView ClauseBank Agent
The ClauseBank Agent provides one-way clause synchronization from 
SharePoint to the user’s local computer profile so that ClauseBank can source 
content locally for previews, clause insertion and expansion.  ClauseLinks for 
which content exists locally can also be expanded even when offline.

This feature of ClauseBank is particularly useful for deployments that are 
geographically diverse and have limited available bandwidth.

After installing ClauseBank the MacroView ClauseBank Agent system tray 
application will start automatically. Please note the pre-requisites required in the 
Installation Guide.  

8.1 Adding libraries for synchronization
In order to have libraries automatically added to the ClauseBank Agent, the Add 
libraries to ClauseBank Agent setting in the ClauseBank Content Source dialog 
must be enabled:

Figure 46: ClauseBank Content Source dialog

Note: After enabling the Add libraries to ClauseBank Agent option, a refresh of 
the source node is required before libraries will commence being added to the 
ClauseBank Agent.

Figure 47: Refresh option on a ClauseBank Source
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8.2 Managing Content Synchronization
When the Add libraries to ClauseBank Agent setting is enabled, expanding sites 
in the ClauseBank tree-view will add discovered libraries to the ClauseBank 
Agent.

The ClauseBank Agent is responsible for managing content sync as well as 
serving local replica content to the ClauseBank Client. The ClauseBank Agent 
process is a per-user single instance application that appears in the system tray 
using this icon.

When you right-click on the ClauseBank Agent system tray icon, you are 
presented with the following context menu:

Figure 48: ClauseBank Agent system tray menu

This menu provides access to the following functionality:

 Manage Content Sync – displays the content synchronization 
management dialog

 Settings – displays the MacroView ClauseBank Agent options

 Sync Now – starts the synchronization process

 Cancel Sync – cancels any currently active synchronizations

 Exit – Exits the MacroView ClauseBank Agent

The Manage Content Sync dialog provides access to libraries that are enabled 
for Content Sync to view their current status as well as the status of their most 
recent synchronization and allows you to work with each synchronisation via a 
right click context menu. 

Figure 49: ClauseBank Agent Manage Content Sync window

The options available on the context menu for each synchronization item are:
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 Open – opens the selected library in the web browser

 Sync Now – queues the selected libraries for immediate 
synchronization

 Cancel Sync – cancels synchronization and removes the selected 
libraries from the sync queue

 Exclude/Include – deletes existing synchronization data for the 
selected libraries and prevents future synchronization from occurring or 
re-enable synchronization of the library

 Remove – deletes existing synchronization data for the selected 
libraries and completely removes them from the ClauseBank Agent

8.3 Troubleshooting Synchronization
This button at the top right of the Manage Content Sync window opens the trace 
files folder.

All ClauseBank Agent data is stored at:

%LocalAppData%\MacroView\ClauseBank\Agent. 

Trace files are store under the Trace sub folder and are split into two files:

 AgentTrace – contains tracing information for the agent itself

 SyncTrace – contains tracing information for synchronization sessions 
initiated by the agent

8.4 Configuring the Agent
The Agent tab on the ClauseBank Options dialog provides access to 
ClauseBank Agent settings. Refer to section 9.1.4.

When accessing this Options dialog via the Settings option on the ClauseBank 
Agent system tray context menu General and Advanced tabs are unavailable. 

8.5 Limitations of the ClauseBank Agent
 The ClauseBank Agent supports SharePoint 2010, 2013 and 

SharePoint Online

 You must have the Background Intelligent Transfer Service enabled in 
Windows (default Windows behaviour) and install all pre-requisites

 You must use Windows authentication for on-premises servers

 Cross-domain authentication scenarios are not supported

 Some deeply-nested library structures may fail to sync if the total path 
length exceeds the Windows filesystem limit
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9 Options
If you click the Options dropdown the ClauseBank Options and About options 
appear. If you click the Options button the ClauseBank Options dialog displays. 
(Figure 50).

9.1 ClauseBank Options
Settings in the ClauseBank Options dialog are implemented through user-based 
registry settings but can also be set and locked by IT administrators using 
Group Policy.

The ClauseBank Options dialog consists of three tabs:
General

Content 

Advanced

Agent

When accessing the dialog from the system tray context menu the General and 
Advanced tabs are unavailable. The Agent has a trace level setting independent 
of the ClauseBank Client as synchronization scheduling and operations 
generate large amounts of tracing when the Information level is selected.

9.1.1 General

Figure 50: The General tab within ClauseBank Options
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Enable ClauseBook
When ClauseBook functionality is enabled, an additional Create ClauseBook 
option is available in the right click menu of the tree when you select a library. 
When this option is clicked, ClauseBank creates a listing of Clause information 
and content from the current Clause library (6.3 above). This functionality is 
particularly useful for Content Managers and ClauseBank administrators.

Allow open in browser
Enabling this option allows you to jump to the current SharePoint site, library or 
folder in your web browser where you may edit content if you have the 
appropriate permissions. Some organisations may prefer that you don't access 
SharePoint directly and will choose to disable this option.

Allow duplicate clauses
When this option is enabled, you are able to insert multiple copies of the same 
clause into a document at the same time. This is convenient for documents that 
require multiple signature blocks for instance.

Figure 51: Allow duplicate clauses.

Display ‘No Category’ category
Adds the ‘No Category’ node to each library in the tree. When you select No 
Category any clauses in that library that do not have a value category assigned 
are displayed.
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Figure 52: The Business Set clause is not assigned to a category.

Display ‘All Categories’ category
Adds the ‘All Categories’ node to each library in the tree. When you select All 
Categories any clauses in that library are displayed regardless of their category. 

Display ‘All Folders’ category
Adds the ‘All Folder’ node to each library in the tree. When you select All 
Folders any clauses in that library or any of its sub folders are displayed. 

Capitalise filter argument
If this option is enabled the Name contains filter argument (text) that you enter 
will be highlighted in each of the clause names that are returned in the filtered 
list by rendering it in uppercase (Figure 53).

Figure 53: Name contains filter showing capitalisation

Note: This options only applies to the Name contains filter argument (text) 
when Display advanced search options is not enabled.

Show expired clauses
When this option is enabled, clauses which have expired are shown with a line 
through the name and the icon following them. See the example below. 
(Figure 54). Though these files can be previewed you cannot select and insert 
these clauses4. If this option is disabled expired clauses will not appear in the 
clause lists.

4 If advanced search is enabled expired clauses may be returned and can be inserted.
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Figure 54: Expired clauses have asterisks on each side of the clause name.

Display view toggle buttons
Enabling this setting will show or hide the Hide Preview and Show Description 
buttons on the ClauseBank dialog. Refer the screenshots below. (Figure 55 and 
Figure 56)

Figure 55: Displaying the view toggle buttons.
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Figure 56: Not displaying the view toggle buttons.

Allow full screen preview
If a clause is selected and this setting is enabled a button appears on the 
ClauseBank dialog that when clicked allows users to view a full screen preview 
of the selected clause. (Figure 57)

If the Use full screen XPS previews option in Options, ClauseBank Options, 
Advance is ticked you will also be able to select and copy text from clauses in 
the full screen preview window.

Figure 57: Displaying the view toggle buttons.
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Figure 58: Multi-page clause displayed in full screen preview window

Clicking the Close cross at the top right of the window will close the full screen 
preview window (Figure 58).

Download clauses for insert
Enabling this option causes ClauseBank to use a web request to download the 
selected clauses to the temporary files path and then insert them into the 
document. By default, the Clause is downloaded to the Internet Explorer 
temporary files area and then inserted using a http call into the document. 
Performance is much improved when inserting a large number of small Clauses 
when this option is used.

Apply design template to inserted slides
Design templates can be applied to a PowerPoint presentation to give it a 
professional look. Enabling this setting will apply the design template used in 
the presentation to all slides that are to be inserted.

Enable New Clause button
Enabling this option allows you to use the New Clause button in Word, 
PowerPoint and Outlook. If this option is not enabled the button remains greyed 
out even when you select the content in the current document, presentation or 
message.

Enable Insert ClauseLink button
Enabling this option allows you to use the Insert ClauseLink button in Word. If 
this option is not enabled the button is removed from both the Home and Insert 
tabs.

Enable Expand ClauseLinks button
Enabling this option allows you to use the Expand ClauseLinks button in Word. 
If this option is not enabled the Expand button is removed from the Home tab 
and the Expand ClauseLinks tick box is removed from the Insert Clause screen.

Language
ClauseBank has support for a number of languages including English, French, 
Spanish, Dutch, German, Russian, Chinese - Simplified, Chinese - Traditional 
and Thai. Please contact MacroView if you would like ClauseBank in another 
language.
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9.1.2 Content
In the Content area of ClauseBank Options, you can add, edit or remove 
ClauseBank Servers. The servers will have been configured by an 
Administrator. Refer to the MacroView ClauseBank Installation Guide for more 
detail.

Figure 59: The Content screen within ClauseBank Options.

When you click the Add button the Add Server dialog displays.

Figure 60: The ClauseBank Add new source dialog.

If you enter a server name and address and tick the Search for ClauseBank 
sites option, when you click OK ClauseBank will perform a search and will 
return all sites with 'ClauseBank' in the site title5. If your ClauseBank source 
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settings change, ClauseBank will refresh your ClauseBank tree-view and clear 
your ClauseBank tree-view cache.

Alternatively you can add individual sites as ClauseBanks by entering a 
business user friendly name for the Name and the site URL for the Address. 
These sites do not have to contain the word ClauseBank.

To synchronize library content to your local computer, enable the Add libraries 
to ClauseBank Agent option.  Refer to section 8 for information on the 
ClauseBank Agent.

9.1.3 Advanced

Figure 61: The Advanced screen within Options, ClauseBank Options

Logging
Allows you to set the amount of information captured by the trace file as 
ClauseBank performs its normal operations. If any exceptions occur these are 
logged in the same trace file. These trace files are vital for MacroView support 
staff to diagnose and resolve issues that may occur.

5 This works for all servers other than WSS 3.0 and Foundation 2010. 
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Enable modeless insert window
Enable Modeless insert window will prevent the ClauseBank window from 
closing when the ‘OK’ button is clicked. The document remains fully accessible 
whilst the ClauseBank window is displayed. Note that only one modeless 
ClauseBank window can be shown per Office application. For example, if you 
are working with multiple Word documents, the modeless window is parented to 
the document that was active when Insert Clause was clicked.

Allow clause insert on right click
If the Allow clause insert on right-click option is ticked an Insert option is added 
to the right click menu when you select a clause in the middle List Box. This 
option can be used with or without the modeless insert window. If the window is 
not modeless it will close after you click Insert. (Figure 62)

Figure 62: Right click Insert available for clauses

Display advanced search options
If you tick the Option, Advanced setting Display advanced search options you 
will be provided with the following dropdown list of filter options instead of the 
standard Name contains or Clause contains options.
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Figure 63 Advanced search options when enabled in Advanced Settings

For a successful search you can enter the asterisk character at the end of parts 
of words.

All advanced search options utilize the SharePoint search service. No client-
side filtering occurs when advanced search options are enabled.

Display preview
Toggles the preview pane on and off on the ClauseBank dialog. (Figure 64 
Preview and description panes off)

Figure 64 Preview and description panes off

Display description
Toggles the description pane on and off in the ClauseBank dialog. (Figure 64 
and Figure 65)

Description text can be copied and can hyperlinks such as http or https URL’s 
and email addresses.
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Figure 65 Description pane on

Display clause URL tooltips
If ticked when you hover over a clause you will see the URL path for that 
clause.

Show clause selection buttons
Toggles the display of the buttons used to move clauses to the third panel, 
buttons used to rearrange the clauses in the third panel and the button used to 
delete a clause from the third panel.

Figure 66 Clause selection buttons off

Enable clause search on sites
If you tick the Option, Advanced setting Enable clause search on sites you can 
enter search criteria into the search panel when you have the ClauseBank site 
selected and search the contents of that entire site. If this option is not enabled 
you can only search within the selected library.

Show clause icons
Toggle the display of Office application icons in the selection list
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Allow Word clauses in PowerPoint
Toggles whether or not using the Insert Clause option in PowerPoint allows 
selection of Word clauses.

Allow PowerPoint slides in Word
Toggles whether or not using the Insert Clause option in Word allows selection 
of PowerPoint slides.

Expand ClauseLinks in headers and footers
Toggles whether or not ClauseLinks in document headers and footers are 
expanded when you click the Expand button.

Display all document libraries
If you tick this option, the ClauseBank navigation tree will show all document 
libraries rather than restricting the tree to only show libraries with a name 
ending in ‘Clauses’ or ‘Slides’.

Use full screen XPS previews
This option will allow you to select and copy text from the clause when using full 
screen preview window.

Enable incremental tree refresh
ClauseBank will incrementally refresh the parent of the currently selected tree 
view item when performing a full refresh of the clauses list at the library/folder or 
category level.

A full refresh of the clauses list occurs when:

 Opening the Insert window.

 Selecting a Library, Category or Folder treeview item.

 Clearing the filter text.

 Right-clicking the clauses list and selecting Refresh. 

Enable Modern Authentication
Once you are signed in with Modern Authentication enabled in MacroView 
ClauseBank, you will only be asked to log in or authenticate if you change your 
password, sign out or do not use ClauseBank for long periods of time.

This means you will not be prompted to authenticate to SharePoint Online each 
time you start ClauseBank.

This setting is enabled by default.

Excluded libraries
Libraries with names specified in this list will be excluded from the ClauseBank 
navigation tree.  This applies even when Display all document libraries is 
selected.
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9.1.4 Agent
The ClauseBank Options dialog contains a tab for Agent settings:

Figure 67: The Agent screen within Options, ClauseBank Options

Trace Level
This setting determines the amount of detail in the Agent and Sync trace files.

The Agent has a trace level setting independent of the ClauseBank Client as 
synchronization scheduling and operations generate large amounts of tracing 
when the Information level is selected. See section 9.1.4 for more details.

Sync Interval
This setting determines the interval at which library synchronization occurs. The 
input box format is Hours:Minutes:Seconds

Maximum Libraries to Sync Simultaneously
This setting determines the number of libraries that can be synced in parallel by 
the ClauseBank Agent.

Sync Batch Size
This setting limits the number of items to retrieve per request.

Automatically Sync New Libraries
This setting determines whether new libraries added to the agent are included 
or excluded by default.



 
MacroView ClauseBank User Guide

Effective: September 2020 46

9.2 About

Figure 68: The About screen within MacroView ClauseBank Options

The About screen displays:
the current version of MacroView ClauseBank
copyright information

MacroView’s contact details

Trace Files button.
When you click on the Trace Files button Windows Explorer opens the 
folder where the MacroView ClauseBank trace files are stored. This 
location varies between operating systems. 

Windows 7, Windows 8, Windows 10
C:\Users\userid\AppData\Roaming\MacroView 
ClauseBank

where userid is the current user login.
Clear Trace Files button.
When you click on the Clear Trace Files button all MacroView ClauseBank 
trace files are deleted.




